GNOME 2.14 Desktop Accessibility Guide
Abstract

The GNOME Accessibility Guide is for users, system administrators, and anyone who is interested in how the GNOME Desktop supports people with disabilities and addresses the requirements of Section 508 of the U.S. Rehabilitation Act.

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License (GFDL), Version 1.1 or any later version published by the Free Software Foundation with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts. You can find a copy of the GFDL at this link [ghelp:fdl] or in the file COPYING-DOCS distributed with this manual.

This manual is part of a collection of GNOME manuals distributed under the GFDL. If you want to distribute this manual separately from the collection, you can do so by adding a copy of the license to the manual, as described in section 6 of the license.

Many of the names used by companies to distinguish their products and services are claimed as trademarks. Where those names appear in any GNOME documentation, and the members of the GNOME Documentation Project are made aware of those trademarks, then the names are in capital letters or initial capital letters.

DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT ARE PROVIDED UNDER THE TERMS OF THE GNU FREE DOCUMENTATION LICENSE WITH THE FURTHER UNDERSTANDING THAT:

1. DOCUMENT IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. THE ENTIRE RISK AS TO THE QUALITY, ACCURACY, AND PERFORMANCE OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS WITH YOU. SHOULD ANY DOCUMENT OR MODIFIED VERSION PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL WRITER, AUTHOR OR ANY CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER; AND

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL THE AUTHOR, INITIAL WRITER, ANY CONTRIBUTOR, OR ANY DISTRIBUTOR OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER DAMAGES ARISING OUT OF OR RELATING TO USE OF THE DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.

Feedback

To report a bug or make a suggestion regarding the GNOME Desktop or this manual, follow the directions in the GNOME Feedback Page [ghelp:gnome-feedback].
# Table of Contents

Preface ........................................................................................................ viii

Who Should Read This Guide ................................................................. viii
How This Guide Is Organized ................................................................. viii
Related Documentation ........................................................................ viii
1. Introduction to Accessibility ............................................................... 2
   Overview of Accessibility .................................................................... 2
2. Configuring the Mouse and Keyboard .................................................. 4
   Configuring the Mouse ........................................................................ 4
   To Configure the Behavior of the Mouse ............................................. 4
   To Configure the Cursor ...................................................................... 5
   To Use the Keyboard to Emulate the Mouse ........................................ 5
   Configuring the Keyboard ................................................................... 5
   To Activate the Keyboard Accessibility Options .............................. 6
   To Enable the Keyboard to Emulate the Mouse .............................. 6
   To Enable the Slow Keys Feature ..................................................... 8
   To Enable the Bounce Keys Feature ................................................. 8
   To Enable the Sticky Keys Feature .................................................. 9
   To Enable Audible Notifications for Toggle Keys ......................... 10
   To Enable the Repeat Keys Feature ................................................ 10
3. Using the Keyboard to Navigate the Desktop ...................................... 13
   Introduction to Keyboard Navigation ................................................. 13
   Essential Keyboard Shortcuts ......................................................... 13
   Global Keyboard Shortcuts ............................................................. 13
   Navigating the Desktop Background ................................................. 14
   Navigating Panels ............................................................................ 15
   To Move a Panel Object .................................................................... 15
   To Navigate Drawers ........................................................................ 16
   To Navigate Menus on Panels ....................................................... 17
   To Navigate Panel Applications ...................................................... 17
   Navigating Your Workspaces ......................................................... 17
   Navigating Windows ........................................................................ 18
   To Give Focus to a Window ............................................................. 18
   To Control a Window ....................................................................... 18
   To Move a Window .......................................................................... 19
   To Resize a Window ......................................................................... 19
   To Navigate Pane windows ................................................................ 20
   Navigating Applications .................................................................... 20
   Essential Keyboard Shortcuts for Navigating Applications ............ 21
   Essential Keyboard Shortcuts for Navigating Dialogs .................... 21
   Navigating the File Manager ............................................................ 22
   To Navigate a Folder ......................................................................... 22
   To Navigate Browser Window Components .................................. 23
   Navigating Help Content in Caret Navigation Mode ....................... 23
   Navigating Standard Elements and Controls ................................... 24
   To Navigate Menus .......................................................................... 24
   To Navigate Buttons ......................................................................... 24
   To Navigate Radio Buttons ............................................................. 25
   To Navigate Check Boxes .............................................................. 25
   To Navigate Text Boxes .................................................................... 26
   To Navigate Spin Boxes .................................................................... 27
   To Navigate Drop-Down Lists ....................................................... 28
   To Navigate Drop-Down Combination Boxes ................................. 28
List of Figures

3.1. Sample Button .................................................................................................................... 24
3.2. Sample Radio Button ........................................................................................................... 25
3.3. Sample Check Box .............................................................................................................. 25
3.4. Sample Single Line Text Box ............................................................................................ 26
3.5. Sample Spin Box ................................................................................................................ 27
3.6. Sample Drop-Down List ..................................................................................................... 28
3.7. Sample Drop-Down Combination Box ................................................................................ 28
3.8. Sample Slider ..................................................................................................................... 29
3.9. Sample Dialog with Tabbed Sections .................................................................................... 30
3.10. Sample Tree Structure ..................................................................................................... 33
List of Tables

2.1. Numeric Keypad to Mouse Function Mapping ................................................................. 7
2.2. Function Key to Mouse Function Mapping on Solaris Systems ........................................... 7
2.3. Sticky Keys Latch or Lock Mode ...................................................................................... 9
2.4. Keyboard Accessibility Status Icons ............................................................................... 10
4.1. Quick Reference to Customizing the Appearance of the Desktop ..................................... 36
4.2. Themes Designed for Accessibility Requirements ............................................................. 37
4.3. Controls Options Designed for Accessibility Requirements .............................................. 38
4.4. Icon Options Designed for Accessibility Requirements ..................................................... 39
Preface

The GNOME 2.10 Desktop Accessibility Guide describes how to configure, customize, and use the accessibility features of the GNOME 2.10 Desktop.

Who Should Read This Guide

This guide is for users, system administrators, and anyone who is interested in how the GNOME 2.14 Desktop supports people with disabilities and addresses the requirements of Section 508 of the U.S. Rehabilitation Act.

How This Guide Is Organized

This guide is structured in the following manner:

• Chapter 1, Introduction to Accessibility introduces you to accessibility in the GNOME Desktop.
• Chapter 2, Configuring the Mouse and Keyboard describes how to configure the mouse and keyboard to make these devices accessible to more users.
• Chapter 3, Using the Keyboard to Navigate the Desktop describes how to navigate the GNOME Desktop from the keyboard.
• Chapter 4, Customizing the Appearance of the Desktop describes the methods you can use to change the appearance of the GNOME Desktop to enhance the accessibility of the desktop for users with visual impairments.
• Chapter 5, Using the Assistive Technologies introduces you to the assistive technologies that are available from the GNOME Desktop.
• Appendix A, System Administration describes the system administrator tasks that you need to perform before you can use the assistive technologies for the GNOME Desktop.

Related Documentation

The following manuals are related to this guide:

• GNOME 2.10 Desktop System Administration Guide
• GNOME 2.10 Desktop User Guide
Chapter 1

Introduction to Accessibility
This chapter introduces you to accessibility in the GNOME Desktop.

**Overview of Accessibility**

All software products should incorporate accessibility features to enable people with disabilities to use the software easily and efficiently. Recent legislation such as Section 508 of the U.S. Rehabilitation Act heightens awareness of the need to provide accessible software.

The GNOME Desktop is easy to use and incorporates many accessibility features. Every supported application and utility in the GNOME Desktop is designed with accessibility and usability in mind. Users with physical disabilities such as low vision or impaired motor skills can use all of the functionality of the GNOME Desktop thanks to the customization tools that are available. The customization tools enable you to customize the appearance and behavior of the desktop.

The ability to easily customize the GNOME Desktop contributes greatly to the accessibility of the desktop. This guide describes the various customization options that you can use to tailor the desktop to suit your particular needs.
Chapter 2

Configuring the Mouse and Keyboard
This chapter describes how to configure the mouse and keyboard to make these devices accessible to more users.

## Configuring the Mouse

Use the Mouse preference tool to configure the mouse to suit your needs. To open the Mouse preference tool, choose Desktop→Preferences→Mouse. The Mouse Preferences dialog is displayed.

### To Configure the Behavior of the Mouse

The following sections describe how to modify the behavior of the mouse to suit your needs.

#### To Configure the Mouse for Left-Handed Use

To configure the mouse for left-handed use, click on the Buttons tab in the Mouse Preferences dialog, then select the Left-handed mouse option. When you select this option, the system swaps the functions of the left mouse button and the right mouse button immediately.

#### To Configure the Double-Click Behavior

If you have difficulty double-clicking, you can increase the period of time that the system allows to elapse between the first click and the second click of a double-click. For example, if the double-click timeout setting is 0.4 seconds, you must perform the second click of a double-click within 0.4 seconds of the first click. If the second click occurs more than 0.4 seconds after the first click, the system interprets the two clicks as two single clicks.

To configure the double-click timeout setting, perform the following steps:

1. Click on the Buttons tab in the Mouse Preferences dialog.
2. Use the Timeout slider to specify the timeout in seconds that the system allows between the two clicks of a double-click. Moving the slider to the right will increase the timeout interval in 0.1 second intervals. In the same manner, moving the slider to the left will decrease the timeout in 0.1 second intervals.
3. Double-click on the light bulb to the right of the slider to test the setting. If you perform the two clicks of the double-click within the timeout specified, the light bulb lights up fully to display a yellow glow around the bulb. If you do not double-click within the timeout specified, the light bulb does not light fully. You should increase the timeout setting and try again. When the light bulb lights, the timeout setting is suitable for your needs.

#### To Change the Size of the Mouse Pointer

To change the size of the mouse pointer that is displayed on the desktop, perform the following steps:

1. Click on the Pointers tab in the Mouse Preferences dialog.
2. This will display a list of pointer themes and sizes available.
3. By default, GNOME does not include mouse pointer themes. Information about installing and using pointer themes can be found in the User Guide [ghelp:user-guide?goscustdesk-54].

On some platforms you must log out and log in again for this setting to take effect.

#### To Locate the Mouse Pointer

If you have difficulty locating the mouse pointer on the screen, you can enable an option to highlight the pointer when you press the Control key. To enable this option, click on the Pointers tab in the Mouse Preferences dialog,
then select the Highlight the pointer when you press Ctrl option. When you press Ctrl, the system displays an animation around the pointer to highlight the pointer.

On some platforms, you must log out and log in again before this setting takes effect.

To Configure the Speed and Sensitivity of the Mouse

To configure the speed and sensitivity of the mouse, perform the following steps:

1. Click on the Motion tab in the Mouse Preferences dialog.
2. Configure the following options:
   - **Acceleration**: Use the slider to specify the speed at which the mouse pointer moves around the screen when you move your mouse.
     If you select a low setting, the mouse pointer moves at a speed similar to the speed at which you are physically moving the mouse. This means that you need to physically move the mouse larger distances to cover the screen area. If you select a high setting, the mouse pointer moves at a faster speed than the speed at which you physically move the mouse. This means that you need to physically move the mouse small distances to cover the screen area.
   - **Sensitivity**: Use the slider to specify how responsive the mouse pointer is to movements of your mouse. Moving the slider to the right will increase the sensitivity and moving it to the left will decrease the sensitivity.
   - **Threshold**: Use the slider to specify the distance that you must move an item before the system interprets the move action as a drag-and-drop action.

To Configure the Cursor

The following section describes how to modify the display characteristics of the cursor.

To Stop the Cursor Blinking

To stop the cursor blinking in text boxes and fields, perform the following steps:

1. Choose Desktop→Preferences→Keyboard to start the Keyboard preference tool.
2. In the Keyboard tabbed section, deselect the Cursor blinks in text boxes and fields option.

To Use the Keyboard to Emulate the Mouse

If you have difficulty using a mouse, you can use the keyboard to emulate the mouse functions. See the section called “To Enable the Keyboard to Emulate the Mouse” of this guide for more information.

Configuring the Keyboard

Use the Keyboard preference tool, to configure the keyboard accessibility options. To open the Keyboard preference tool, choose Desktop→Preferences→Keyboard. Accessibility options can be enabled by selecting Accessibility. This will open a new dialog, Keyboard Accessibility Preferences, also known as AccessX.
Before you can use the Keyboard Accessibility preference tool on Solaris systems, you must follow the steps outlined in the section called “Enabling XKB on Solaris Systems” of this guide.

The Keyboard Accessibility Preferences (AccessX) dialog enables you to customize your keyboard in the following ways:

- To use the numeric keypad to emulate mouse actions. See the section called “To Enable the Keyboard to Emulate the Mouse”.
- To specify the duration for which you must press-and-hold a key before the system accepts the keypress. See the section called “To Enable the Slow Keys Feature”.
- To ignore rapid, repeated keypresses of the same key. See the section called “To Enable the Bounce Keys Feature”.
- To accept key combinations in sequence rather than simultaneously. See the section called “To Enable the Sticky Keys Feature”.
- To emit an audible notification when a user activates or deactivates a toggle key. See the section called “To Enable Audible Notifications for Toggle Keys”.
- To ignore long keypresses of the same key and control the repeat rate of a keypress. See the section called “To Enable the Repeat Keys Feature”.

To Activate the Keyboard Accessibility Options

To activate the keyboard accessibility options, perform the following steps:

1. Choose Desktop → Preferences → Keyboard and select Accessibility
2. Select the Enable keyboard accessibility features option.
3. Click on the Basic tab.
4. Select the Beep when features turned on or off from keyboard option to receive an audible notification each time a user enables or disables a keyboard accessibility option using the following keyboard shortcuts:
   - Press-and-hold Shift for eight seconds to enable or disable the slow keys feature.
   - Press Shift five times to enable or disable the sticky keys feature.
5. To automatically disable the keyboard accessibility options if the options are not used for a specified number of seconds, select the Disable if unused for X seconds option. Use the slider to specify the number of seconds of keyboard idle time required before the system disables the keyboard accessibility options.
   - This option is intended for computers that are shared by a number of different users, some of whom require the keyboard accessibility options.
6. Changes made will be instantly applied.

To Enable the Keyboard to Emulate the Mouse

The mouse keys feature enables you to use the numeric keypad on the keyboard to emulate mouse actions. This feature benefits users who have difficulty using a mouse or other pointing device. To enable and configure the mouse keys feature, perform the following steps:

1. In the Keyboard Accessibility Preferences (AccessX) dialog, select the Mouse Keys tab.
2. Select the Enable Mouse Keys option.
3. Configure the following options to determine the behavior of the mouse pointer when you control the pointer from the numeric keypad:
Maximum pointer speed
Use this spin box to specify the maximum speed, in pixels per second, at which the pointer moves around the screen.

Time to accelerate to maximum speed
Use this spin box to specify the duration, in milliseconds, before the pointer accelerates to the maximum pointer speed.

Delay between keypress and pointer movement
Use this spin box to specify the interval, in milliseconds, between a keypress and the time when the pointer starts to move.

When you enable mouse keys, the keys on the numeric keypad have the following functions:

**Table 2.1. Numeric Keypad to Mouse Function Mapping**

<table>
<thead>
<tr>
<th>Numeric Keypad Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 2, 3, 4, 6, 7, 8, 9</td>
<td>Move the mouse pointer around the screen</td>
</tr>
<tr>
<td>5</td>
<td>Mouse button click</td>
</tr>
<tr>
<td>0</td>
<td>Mouse button toggle</td>
</tr>
<tr>
<td>/</td>
<td>Primary mouse button</td>
</tr>
<tr>
<td>*</td>
<td>Secondary mouse button</td>
</tr>
<tr>
<td>-</td>
<td>Tertiary mouse button</td>
</tr>
</tbody>
</table>

The toggle mouse button key enable the currently selected mouse button until the Mouse button click key is pressed. This allows you to perform drag and drop operations.

The Mouse button click emulates the currently selected mouse button. Pressing /, * or - will change the behaviour of this. The currently selected mouse button can be seen in the Keyboard Accessibility Status panel application, discussed in the section called “Using the Keyboard Accessibility Status Panel Application”.

- The Primary mouse button is the left mouse button for right handed people. The Secondary mouse button is the right mouse button and the Tertiary mouse button is the middle mouse button.

Some Solaris systems also use the function keys to emulate the mouse buttons. The common function key to mouse button mappings are described in the following table.

**Table 2.2. Function Key to Mouse Function Mapping on Solaris Systems**

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Mouse button 1</td>
</tr>
<tr>
<td>F3</td>
<td>Mouse button 2</td>
</tr>
</tbody>
</table>
To Enable the Slow Keys Feature

The slow keys feature enables you to customize how the keyboard handles user input in the following ways:

- Specify the duration for which you must press-and-hold a key before the system accepts the keypress. This aspect of the feature benefits users who frequently press keys that they do not intend to press.
- Enable audible indications of keyboard input and acceptance. This aspect of the feature benefits users who cannot see the result of a keypress.

To enable and configure the slow keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) dialog, select the Filters tab.
2. Select the Enable Slow Keys option.

To select or deselect the slow keys feature from the keyboard, press-and-hold Shift for eight seconds. This will present a dialog confirming that you with slow keys enabled. The Shift keyboard shortcut automatically selects all of the slow keys options. If you selected the Beep when features turned on or off from the keyboard option in the Basic tab, after four seconds the system beeps three times to indicate that the system is about to select or deselect the feature.

3. Use the Only accept keys held for slider or spin box to specify the duration, in milliseconds, for which you must press-and-hold a key before the system accepts the keypress. Use the Type to test settings text box to test the slow keys setting and modify the setting as required.
4. To enable audible indications of keyboard input and acceptance, select the following options:

   - Beep when key is pressed
     Select this option to hear a beep when you press a key.
   - Beep when key is accepted
     Select this option to hear a beep when the system accepts a keypress.
   - Beep when key is rejected
     Select this option to hear a beep when the system rejects a keypress. The system rejects a keypress if you do not press-and-hold the key for the duration that is specified in the Only accept keys held for spin box.

To Enable the Bounce Keys Feature

The bounce keys feature enables you to customize the keyboard to ignore rapid, repeated keypresses of the same key. For example, users with impaired motor skills might press the same key several times when they intend to press the key once. This feature enables you to customize the keyboard to ignore repeated keypresses.

To enable and configure the bounce keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) dialog select the Filters tab.
2. Select the Enable Bounce Keys option.

3. Use the Ignore duplicate keypresses within slider or spin box to specify the duration in milliseconds (ms) after the first keypress for which the system ignores repeated keypresses of the same key. For example, if you select a duration of 500 ms, the system ignores all repeated keypresses of the same key that occur within 500 ms of the first keypress.

To select or deselect the bounce keys feature from the keyboard, press-and-hold Shift for eight seconds. This will present a dialog confirming that you with bounce keys enabled. The Shift keyboard shortcut automatically selects all of the bounce keys options. If you selected the Beep when features turned on or off from the keyboard option in the Basic tab, after four seconds the system beeps three times to indicate that the system is about to select or deselect the feature.

To enable audible indications of keyboard input and acceptance, select the following options:

   - Beep when key is pressed
     Select this option to hear a beep when you press a key.
   - Beep when key is accepted
     Select this option to hear a beep when the system accepts a keypress.
   - Beep when key is rejected
     Select this option to hear a beep when the system rejects a keypress. The system rejects a keypress if you do not press-and-hold the key for the duration that is specified in the Ignore duplicate keypresses within spin box.

Chapter 2. Configuring the Mouse and Keyboard Configuring the Keyboard

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4</td>
<td>Mouse button 3</td>
</tr>
</tbody>
</table>
4. Select the Beep if key is rejected option to hear an audible indication when the system ignores a key.

If you want to enable the bounce keys feature, ensure that the Enable Slow Keys option is deselected. The slow keys feature requires you to press a key for a specified duration before the system accepts the keypress as a valid keypress. If you cannot press the key for the duration that is specified by the slow keys setting, deselect the Enable Slow Keys option to enable the system to accept your input.

To Enable the Sticky Keys Feature

The sticky keys feature enables you to press the keys in a key combination in sequence rather than simultaneously. This feature is designed for users who are unable to press two or more keys simultaneously.

To enable and configure the sticky keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) select the Basic tab.
2. Select the Enable Sticky Keys option.

To enable the sticky keys feature from the keyboard, press Shift five times. This will present a dialog confirming that you wish to enable sticky keys. The Shift keyboard shortcut automatically selects all of the sticky keys options. If you selected the Beep when features turned on or off from the keyboard option, the system beeps to indicate that the system is about to select or deselect the feature. When active, pressing shift five times in a row will present a dialog asking if you want to disable sticky keys.

3. Select the Beep when modifier is pressed option to receive an audible indication each time you press a modifier key such as Ctrl, Alt, or Shift. This option is useful to remind you whether a modifier key is active or inactive.
4. Selecting the Disable if two keys pressed together option will present a dialog with the option to disable sticky keys if two keys are pressed at the same time.

You can use the sticky keys feature in latch or lock mode. The following table describes how to choose a mode and the difference between the two modes.

Table 2.3. Sticky Keys Latch or Lock Mode

<table>
<thead>
<tr>
<th>To use the sticky keys feature in...</th>
<th>Press the modifier key...</th>
<th>The modifier key remains active until...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latch mode</td>
<td>Once.</td>
<td>You press a non-modifier key.</td>
</tr>
<tr>
<td>Lock mode</td>
<td>Twice in quick succession.</td>
<td>You press the modifier key again.</td>
</tr>
</tbody>
</table>

Example 1: If you want to press Alt-F1, do the following:

1. Press Alt to latch the modifier key. The Alt key remains active.
2. Press F1. The key combination is now complete. After you press F1, the Alt modifier key is no longer active.

Example 2: If you want to press Ctrl-Alt-Tab, do the following:

1. Press Ctrl twice to lock the modifier key. The Ctrl key remains active.
2. Press Alt.
3. Press Tab. The key combination is now complete.
4. To unlock the modifier key, press Ctrl again.

**To Enable Audible Notifications for Toggle Keys**

A toggle key is any key on the keyboard that can switch between two states. The Num Lock, Caps Lock, and Scroll Lock keys are toggle keys. Most toggle keys have an associated light emitting diode (LED) on the keyboard that lights when the toggle key is active. To assist users with visual impairments, you can customize the keyboard to emit an audible notification when a user presses a toggle key. For example, when you press Num Lock, you can determine whether the key is toggled or not toggled by the sound that the keyboard emits.

To enable accessible toggle keys, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccesX) select the Filters tab.
2. Select the Enable Toggle Keys option.

When you activate the Num Lock, Caps Lock, or Scroll Lock keys, the system beeps once. When you deactivate a toggle key, the system beeps twice.

**To Enable the Repeat Keys Feature**

The repeat keys feature enables you to repeat a keystroke multiple times without pressing the key more than once. This feature is designed for users who cannot release keys quickly, for example users who operate a mouth stick. When you enable repeat keys, you can specify the duration for which you must press a key before the key starts to repeat.

To enable and configure the repeat keys feature, perform the following steps:

1. From the Keyboard Accessibility Preferences (AccessX) select the Basic tab.
2. Select the Enable Repeat Keys option.
3. Use the Delay slider or spin box to specify the duration for which you must press a key before the keyboard interprets the action as a repeat key. If you have difficulty releasing keys, select a long time delay.
4. Use the Speed slider or spin box to specify the speed at which the keyboard repeats the keypress as input.

**Using the Keyboard Accessibility Status Panel Application**

The Keyboard Accessibility Status panel application shows you the status of the keyboard accessibility features. This panel application displays icons to indicate which keyboard accessibility features are enabled in the Keyboard Accessibility preference tool.

To add the Keyboard Accessibility Status panel application to a panel, right-click on the panel, then choose Add to Panel and select the Keyboard Accessibility Status.

The following table describes the icons that the panel application displays and the status that each icon represents.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Keyboard Accessibility Status</th>
</tr>
</thead>
</table>

Table 2.4. Keyboard Accessibility Status Icons
<table>
<thead>
<tr>
<th>Icon</th>
<th>Keyboard Accessibility Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Keyboard accessibility in general is available but none of the individual key features are enabled.</td>
</tr>
<tr>
<td></td>
<td>The bounce keys feature is enabled.</td>
</tr>
<tr>
<td></td>
<td>The mouse keys feature is enabled. The dot in the mouse button shows which button is currently associated with the Mouse button click key.</td>
</tr>
<tr>
<td></td>
<td>The slow keys feature is enabled.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Alt</em> key is latched.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Alt</em> key is locked.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Ctrl</em> key is latched.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Ctrl</em> key is locked.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Shift</em> key is latched.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Shift</em> key is locked.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Super/Windows</em> key is latched.</td>
</tr>
<tr>
<td></td>
<td>The sticky keys feature is enabled and the <em>Super/Windows</em> key is locked.</td>
</tr>
</tbody>
</table>
Chapter 3

Using the Keyboard to Navigate the Desktop
This chapter describes how to navigate the GNOME Desktop from the keyboard only. Users who have difficulty using a mouse or other pointing device can navigate and use the desktop from the keyboard.

Introduction to Keyboard Navigation

This section describes the essential keyboard shortcuts to enable you to navigate the desktop from the keyboard.

You can customize some of the keyboard shortcuts that are described in this chapter. The text indicates the shortcuts that you can customize. See the section called “Customizing Your Keyboard Shortcuts” for information about how to customize keyboard shortcuts.

Essential Keyboard Shortcuts

The following table lists the essential keyboard shortcuts that you can use to navigate the desktop. The keyboard shortcuts that you use to navigate specific elements and controls are described in the appropriate sections of this chapter.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Give focus to the next element or control.</td>
</tr>
<tr>
<td>Shift-Tab</td>
<td>Reverse the navigation direction and give focus to the previous element or control. In general, the Shift key reverses the navigation direction.</td>
</tr>
<tr>
<td>Ctrl-Tab</td>
<td>Give focus to the next element or control, if the Tab key has a specific purpose in a control. For example, if you press Tab in a text box, the system inserts a tab space. To give focus to the previous element or control, press Shift-Ctrl-Tab.</td>
</tr>
<tr>
<td>arrow keys</td>
<td>Navigate within an element or control.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Activate the element or control that has focus. For example, if the current control is a button, this action is the equivalent of clicking on the button with a mouse.</td>
</tr>
<tr>
<td>Esc</td>
<td>Close a window, menu, or drawer.</td>
</tr>
<tr>
<td>F7</td>
<td>Switch to caret navigation mode. Caret navigation mode enables you to use the keyboard to select text. For more information about caret navigation mode, see the section called “Navigating Help Content in Caret Navigation Mode”.</td>
</tr>
</tbody>
</table>

Global Keyboard Shortcuts

The following table lists the keyboard shortcuts that you can use from any part of the GNOME Desktop.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-F1</td>
<td>Open the Main Applications Menu.</td>
</tr>
</tbody>
</table>
### Keys

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alt-F2</strong></td>
</tr>
<tr>
<td><strong>Print Screen</strong></td>
</tr>
<tr>
<td><strong>Alt-Print Screen</strong></td>
</tr>
<tr>
<td><strong>F1</strong></td>
</tr>
<tr>
<td><strong>Ctrl-F1</strong></td>
</tr>
<tr>
<td><strong>Shift-F10</strong></td>
</tr>
</tbody>
</table>

### Navigating the Desktop Background

The desktop background is the part of the GNOME Desktop where there are no interface items or applications, such as panels and windows. The following table lists the keyboard shortcuts that you can use to navigate the desktop background and the desktop background objects. A desktop background object is an icon on the desktop background that you can use to open files, folders, or applications.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ctrl-Alt-D</strong></td>
<td>Temporarily hide all windows and give focus to the desktop background. To restore the windows, press <strong>Ctrl-Alt-D</strong> again. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td><strong>Ctrl-Alt-Tab</strong></td>
<td>Display a popup window with icons that represent the desktop background and the panels. Press-and-hold <strong>Ctrl-Alt</strong> and continue to press <strong>Tab</strong> to switch the focus between the desktop background and the panels. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td><strong>arrow keys</strong></td>
<td>When the desktop background or a desktop background object has focus, give focus to a neighboring desktop background ob-</td>
</tr>
</tbody>
</table>
A sequence of characters that matches the first n characters of a desktop background object name. When the desktop background has focus, give focus to the desktop background object whose name starts with the specified sequence of characters.

F2
Rename the desktop background object that has focus.

Shift-F10
Open the popup menu for the desktop background object that has focus.

Ctrl-F10
Open the Desktop Background menu.

Navigating Panels

A panel is an area from which you can run special programs, applications, and panel applications. The most common panel is the panel that stretches the full width of the bottom edge of the desktop. The following table lists the keyboard shortcuts that you can use to navigate panels and panel objects.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-Alt-Tab</td>
<td>Give focus to a panel. This keyboard shortcut displays a popup window with icons that represent the desktop background, panels, and drawers. Press-and-hold Ctrl-Alt and continue to press Tab to switch the focus between the desktop background, panels, and drawers. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Tab</td>
<td>Give focus to the next object on the panel.</td>
</tr>
<tr>
<td>F10</td>
<td>Open the Applications menu when the Menu Panel has focus. Continue to press F10 to switch focus between the Applications menu and the window list.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Activate a panel object, for example, open a menu or start a launcher.</td>
</tr>
<tr>
<td>Shift-F10</td>
<td>Open the panel object popup menu.</td>
</tr>
<tr>
<td>Ctrl-F10</td>
<td>Open the panel popup menu.</td>
</tr>
</tbody>
</table>

To Move a Panel Object

You can move a focused panel object to a different location on a panel or drawer, or you can move the object to the next panel. To move a panel object, perform the following steps:

1. Press Tab to give focus to the object.
2. Press **Shift-F10** to open the panel object popup menu.
3. Use the arrow keys to select the Move menu item.
4. Use the keyboard shortcuts that are listed in the following table to perform the move operation.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>arrow keys</td>
<td>Move the object left and right on a horizontal panel or up and down on a vertical panel.</td>
</tr>
<tr>
<td><strong>Shift</strong> + arrow keys</td>
<td>Move the object and push any objects that you encounter in front of the object.</td>
</tr>
<tr>
<td><strong>Ctrl</strong> + arrow keys</td>
<td>Move the object and swap position with any objects that you encounter in the move.</td>
</tr>
<tr>
<td>Tab</td>
<td>Move the object to the next panel.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Complete the move operation.</td>
</tr>
</tbody>
</table>

The following examples demonstrate the effect of different move operations on the objects in a panel.

<table>
<thead>
<tr>
<th>Illustration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Panel" /></td>
<td>Shows a panel with three panel objects before a move operation takes place.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Panel" /></td>
<td>Shows the effect of using the arrow keys to move the Geyes panel application on the panel. You can use the arrow keys to move the panel application left or right until you meet the next panel object.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Panel" /></td>
<td>Shows the effect of using <strong>Shift</strong> + arrow keys to move the Geyes panel application on the panel. You can use the <strong>Shift</strong> + arrow keys to push the Volume Control and Help panel objects ahead of the object that you are moving.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Panel" /></td>
<td>Shows the effect of using <strong>Ctrl</strong> + arrow keys to move the Geyes panel application on the panel. You can use the <strong>Ctrl</strong> + arrow keys to swap position with the Volume Control and Help panel objects as you meet the objects.</td>
</tr>
</tbody>
</table>

Panel applications that are Locked cannot be moved. To unlock a panel application, use the panel object menu and unselect Lock to Panel.

**To Navigate Drawers**

A drawer is a collapsible extension of a panel. The following table lists the keyboard shortcuts that you can use to navigate into and out of drawers. When you open a drawer, you can navigate the contents of the drawer in the same way as you navigate a panel. See the section called “Navigating Panels” for information about how to navigate a panel.
### To Navigate Menus on Panels

The following table lists the keyboard shortcuts that you can use to navigate menus on panels.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>spacebar</td>
<td>Open the menu that has focus.</td>
</tr>
<tr>
<td>arrow keys</td>
<td>Navigate the menu.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Select a menu item.</td>
</tr>
<tr>
<td>Shift-F10</td>
<td>Open the popup menu associated with a menu item, if one exists.</td>
</tr>
<tr>
<td>Esc</td>
<td>Close a menu.</td>
</tr>
</tbody>
</table>

### To Navigate Panel Applications

A panel application is a small application that resides on a panel. You can navigate to all panel applications and open the panel application popup menu from the keyboard. However, if the panel application does not contain controls that you can give focus to, you cannot navigate the controls in the panel application. The following table lists the keyboard shortcuts that you can use to navigate panel applications.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>spacebar</td>
<td>Activate the panel application control that has focus, if applicable. Not all panel applications contain controls that you can activate. If the panel application does not contain a control that you can activate, the <code>spacebar</code> does nothing.</td>
</tr>
<tr>
<td>arrow keys</td>
<td>Navigate the controls on the panel application.</td>
</tr>
<tr>
<td>Shift-F10</td>
<td>Open the panel application popup menu. To navigate the menu, use the standard keyboard shortcuts for navigating menus. To navigate menus, see the section called “To Navigate Menus” for information about how to navigate menus.</td>
</tr>
</tbody>
</table>

### Navigating Your Workspaces
A workspace is a discrete area in which you can work. You can have many workspaces on your desktop and you can switch from one workspace to another. Each workspace can contain different windows and processes. The following table lists the keyboard shortcuts that you can use to navigate workspaces.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-Alt + arrow keys</td>
<td>Give focus to the next or previous workspace. This keyboard shortcut displays a popup window with icons that represent the workspaces. Press and hold Ctrl-Alt and continue to press the arrow keys to switch the focus between the workspaces. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Ctrl-Shift-Alt + arrow keys</td>
<td>Move the window that has focus to the next or previous workspace. You can customize this keyboard shortcut.</td>
</tr>
</tbody>
</table>

## Navigating Windows

The following sections describe the keyboard shortcuts that you can use to navigate windows. A window is a rectangular frame on your screen that displays an application.

You can customize all of the keyboard shortcuts that are associated with navigating windows. See the section called “Navigating Your Workspaces” for more information.

### To Give Focus to a Window

Before you can use or modify a window, you must give focus to the window. The following table lists the keyboard shortcuts that you can use to give focus to a window.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-Tab</td>
<td>Display a popup window with icons that represent each window. Press-and-hold Alt and continue to press Tab to move through the windows until you reach the window to which you want to give focus.</td>
</tr>
<tr>
<td>Alt-Esc</td>
<td>Raise each window in turn until you reach the window to which you want to give focus.</td>
</tr>
</tbody>
</table>

### To Control a Window

When a window has focus, you can perform various actions on the window. The following table lists the keyboard shortcuts that you can use to control the window that has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
</table>
Chapter 3. Using the Keyboard to Navigate the Desktop

Navigating Windows

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-spacebar</td>
<td>Open the Window Menu.</td>
</tr>
<tr>
<td>Alt-F4</td>
<td>Close the window.</td>
</tr>
<tr>
<td>Solaris: Open</td>
<td>Minimize the window.</td>
</tr>
<tr>
<td>Linux: Alt-F9</td>
<td></td>
</tr>
<tr>
<td>Alt-F10</td>
<td>Maximize the window.</td>
</tr>
<tr>
<td>Alt-F5</td>
<td>Restore a maximized window to the original size of the window.</td>
</tr>
</tbody>
</table>

To Move a Window

When a window has focus, you can move the window around the screen. The following table lists the keyboard shortcuts that you can use to move a window.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-F7</td>
<td>Start the move operation. The mouse pointer changes to a cross.</td>
</tr>
<tr>
<td>arrow keys</td>
<td>Move the window 10 pixels at a time in the direction of the arrow key.</td>
</tr>
<tr>
<td>Ctrl + arrow keys</td>
<td>Move the window one pixel at a time in the direction of the arrow key.</td>
</tr>
<tr>
<td>Shift + arrow keys</td>
<td>Move the window in the direction of the arrow key to align it with the edge of the nearest window, panel, or screen edge.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Complete the move operation and leave the window in the current position.</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancel the move operation and restore the window to the original position.</td>
</tr>
</tbody>
</table>

To Resize a Window

When a window has focus, you can increase or decrease the size of the window. The following table lists the keyboard shortcuts that you can use to resize the window that has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-F8</td>
<td>Start the resize operation.</td>
</tr>
<tr>
<td>arrow keys</td>
<td>Resize the window in the direction of the arrow keys.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Complete the resize operation and leave the window at the current size.</td>
</tr>
</tbody>
</table>
To Navigate Paned Windows

A paned window is a window that is split into two or more panes. The Help browser is an example of an application that uses paned windows.

The following table describes the keyboard shortcuts that you can use to navigate windows with panes.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Give focus to the next pane. The system gives focus to the control that last had focus in the pane.</td>
</tr>
<tr>
<td>F8</td>
<td>Give focus to the first resize handle in the window. The resize handle is displayed between the panes and enables you to resize the panes. Press F8 again to give focus to the next resize handle.</td>
</tr>
</tbody>
</table>

When the resize handle has focus, you can use the keyboard shortcuts that are listed in the following table to modify the paned window.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>arrow keys</td>
<td>Move the resize handle by a small amount.</td>
</tr>
<tr>
<td>Ctrl + arrow keys</td>
<td>Move the resize handle by a large amount.</td>
</tr>
<tr>
<td>Home</td>
<td>Reduce the size of the pane to the left of the resize handle for vertical panes, or above the resize handle for horizontal panes, to the minimum size allowed.</td>
</tr>
<tr>
<td>End</td>
<td>Increase the size of the pane to the left of the resize handle for vertical panes, or above the resize handle for horizontal panes, to the maximum size allowed.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Set the position of the resize handle and return the focus to the last control that had focus.</td>
</tr>
<tr>
<td>Esc</td>
<td>Reset the position of the resize handle to the original position and return the focus to the last control that had focus.</td>
</tr>
</tbody>
</table>

Navigating Applications

An application is any program, utility, or other software package that you run on your desktop. Applications comprise the following standard user interface components:
Windows
A window is a rectangular frame on your screen that displays an application. See the section called “Navigating Windows” for information about how to navigate windows.

Dialogs
A dialog is a popup window in which you enter information or commands. See the section called “Essential Keyboard Shortcuts for Navigating Dialogs” for information about how to navigate dialogs.

Controls
A control is an instrument that you use to operate or guide the user interface. For example, buttons, check boxes, menus, and text boxes are controls. See the section called “Navigating Standard Elements and Controls” for detailed information about how to navigate the different types of controls that are available.

This section of the manual describes the essential keyboard shortcuts that you can use to start using applications and dialogs.

Essential Keyboard Shortcuts for Navigating Applications

Since there are many applications that you can use in the GNOME Desktop, this manual does not describe the keyboard shortcuts that you can use to navigate all of the different applications. However, the basic keyboard shortcuts are common to all applications. Access keys also provide an efficient way to navigate an application from the keyboard. An access key is identified by an underlined letter on a menu or control. In some cases, you must press Alt in combination with the access key to perform an action.

The following table lists the essential keyboard shortcuts that you can use to navigate applications.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F10</td>
<td>Open the first menu on the application menubar.</td>
</tr>
<tr>
<td>Alt + access key</td>
<td>Open the menu that is associated with the access key.</td>
</tr>
<tr>
<td>access keys</td>
<td>Select the menu item that is associated with the access key.</td>
</tr>
<tr>
<td>left arrow and right arrow</td>
<td>Switch focus between the menus on the menubar.</td>
</tr>
<tr>
<td>up arrow and down arrow</td>
<td>Move focus into a menu.</td>
</tr>
<tr>
<td>Esc</td>
<td>Close the open menus and give focus to the control that had focus before the menubar.</td>
</tr>
<tr>
<td>Ctrl-O</td>
<td>Open the file selector dialog.</td>
</tr>
<tr>
<td>Ctrl-S</td>
<td>Open the Save dialog.</td>
</tr>
<tr>
<td>Ctrl-L</td>
<td>Open a Location dialog to enable you to type the name of the file that you want to open or save.</td>
</tr>
</tbody>
</table>

Essential Keyboard Shortcuts for Navigating Dialogs

The following table lists the essential keyboard shortcuts that you can use to navigate dialogs.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

21
Navigating the File Manager

By default, the file manager operates in Spatial mode. This mode uses separate windows for each folder. A separate mode, called Browser mode, exists that uses the same window for each folder.

For more information about different modes for the file manager, see the user guide [ghelp:user-guide?nautilus-presentation].

To Navigate a Folder

The following table describes the keyboard shortcuts that enable you to navigate folders in the file manager.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>arrow keys</td>
<td>Select the next or previous file or folder in the direction of the arrow key.</td>
</tr>
<tr>
<td>Ctrl + arrow keys</td>
<td>Give focus to the next or previous file or folder but do not select the item. This allows multiple files to be selected.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Open the focused file or folder.</td>
</tr>
<tr>
<td>Ctrl + spacebar</td>
<td>Select the item that currently has focus.</td>
</tr>
<tr>
<td>A sequence of characters that matches the first ( n ) characters of a filename.</td>
<td>Select the first file or folder that starts with the specified sequence of characters.</td>
</tr>
<tr>
<td>Home</td>
<td>Select the first file or folder within the current folder.</td>
</tr>
<tr>
<td>End</td>
<td>Select the last file or folder within the current folder.</td>
</tr>
<tr>
<td>backspace</td>
<td>Open the current folder's parent folder.</td>
</tr>
</tbody>
</table>
To Navigate Browser Window Components

When operating in browser mode, the file manager window contains several components and there are different keyboard shortcuts defined to navigate each component.

The following table describes the keyboard shortcuts that enable you to navigate between the components.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Switch focus between the side pane and the view pane.</td>
</tr>
<tr>
<td>Shift-F10</td>
<td>Open the side pane popup menu.</td>
</tr>
</tbody>
</table>

Navigating Help Content in Caret Navigation Mode

The following table describes how to navigate HTML-based help content in caret navigation mode in the Yelp help browser. Caret navigation is a mode of operation in an application which enables you to use the keyboard to select text.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F7</td>
<td>Switch to caret navigation mode.</td>
</tr>
<tr>
<td>left arrow</td>
<td>Move one character to the left.</td>
</tr>
<tr>
<td>right arrow</td>
<td>Move one character to the right.</td>
</tr>
<tr>
<td>up arrow</td>
<td>Move up one line.</td>
</tr>
<tr>
<td>down arrow</td>
<td>Move down one line.</td>
</tr>
<tr>
<td>Ctrl + left arrow</td>
<td>Move to the beginning of the previous word.</td>
</tr>
<tr>
<td>Ctrl + right arrow</td>
<td>Move to the end of the next word.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scroll up one page of content.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scroll down one page of content.</td>
</tr>
<tr>
<td>Home</td>
<td>Move to the beginning of the current line.</td>
</tr>
<tr>
<td>End</td>
<td>Move to the end of the current line.</td>
</tr>
<tr>
<td>Shift + arrow keys</td>
<td>Move from the current position to the destination position and select all text between the two positions.</td>
</tr>
</tbody>
</table>
Navigating Standard Elements and Controls

The following sections describe how to navigate and use standard user interface elements and controls from the keyboard.

To Navigate Menus

The following table lists the keyboard shortcuts that you can use to navigate menus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>up arrow and down arrow</td>
<td>Give focus to the next or previous menu item on a menu.</td>
</tr>
<tr>
<td>right arrow</td>
<td>If the menu item that has focus is a submenu, open the submenu and give focus to the first menu item on the submenu.</td>
</tr>
<tr>
<td></td>
<td>If the menu item that has focus is not a submenu, open the next menu on the menubar.</td>
</tr>
<tr>
<td>left arrow</td>
<td>If the menu item that has focus is a submenu item, switch the focus back to the submenu.</td>
</tr>
<tr>
<td></td>
<td>If the menu item that has focus is not a submenu item, open the previous menu on the menubar.</td>
</tr>
<tr>
<td>Return</td>
<td>Select the focused menu item and close the open menus.</td>
</tr>
<tr>
<td>access key</td>
<td>Select the menu item that is associated with the access key and close the open menus.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Select the focused menu item and close the open menus except when the menu item is a check box or radio button. If the menu item is a check box or radio button, the menu does not close.</td>
</tr>
<tr>
<td>Esc</td>
<td>Close the open menus.</td>
</tr>
</tbody>
</table>

To Navigate Buttons

A button is a control that you use to start an action. Most buttons are rectangular and contain a text label.

Figure 3.1. Sample Button
The following table lists the keyboard shortcuts that you can use to navigate buttons.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>spacebar</td>
<td>Activate the button that has focus. This is the equivalent of clicking on the button.</td>
</tr>
<tr>
<td>Return</td>
<td>Activate the button that has focus or, if no button has focus, perform the default action for the dialog.</td>
</tr>
</tbody>
</table>

**To Navigate Radio Buttons**

A radio button is a control that you use to select one of several mutually-exclusive options.

**Figure 3.2. Sample Radio Button**

The following table lists the keyboard shortcuts that you can use to navigate a set of radio buttons.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>arrow keys</td>
<td>Select the next or previous radio button and deselect the other radio buttons in the group.</td>
</tr>
</tbody>
</table>

**To Navigate Check Boxes**

A check box is a control that you use to select or deselect an option.

**Figure 3.3. Sample Check Box**

The following table lists the keyboard shortcuts that you can use to navigate a check box.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>spacebar</td>
<td>Select or deselect the check box.</td>
</tr>
</tbody>
</table>
To Navigate Text Boxes

Text boxes are controls in which you type text.

Figure 3.4. Sample Single Line Text Box

The following table lists the keyboard shortcuts that you can use to navigate a single line text box.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>left arrow</td>
<td>Position the cursor one character to the left.</td>
</tr>
<tr>
<td>right arrow</td>
<td>Position the cursor one character to the right.</td>
</tr>
<tr>
<td>Ctrl-left arrow</td>
<td>Position the cursor at the start of the current word. Press-and-hold Ctrl and continue to press left arrow to position the cursor at the start of the previous word.</td>
</tr>
<tr>
<td>Ctrl-right arrow</td>
<td>Position the cursor at the end of the current word. Press-and-hold Ctrl and continue to press right arrow to position the cursor at the end of the next word.</td>
</tr>
<tr>
<td>Home</td>
<td>Position the cursor at the start of the line.</td>
</tr>
<tr>
<td>End</td>
<td>Position the cursor at the end of the line.</td>
</tr>
<tr>
<td>Shift-left arrow</td>
<td>Select one character at a time to the left of the cursor.</td>
</tr>
<tr>
<td>Shift-right arrow</td>
<td>Select one character at a time to the right of the cursor.</td>
</tr>
<tr>
<td>Shift-Home</td>
<td>Select all text to the left of the cursor.</td>
</tr>
<tr>
<td>Shift-End</td>
<td>Select all text to the right of the cursor.</td>
</tr>
<tr>
<td>Ctrl-A</td>
<td>Select all text in the text box.</td>
</tr>
</tbody>
</table>

In addition to the keyboard shortcuts listed in the previous table, use the keyboard shortcuts in the following table to navigate multi-line text boxes.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Up</td>
<td>Position the cursor at the top of the current view. Press Page Up again to position the cursor at the top of the previous view.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Position the cursor at the end of the current view. Press Page Down again to position the cursor at the end of the previous view.</td>
</tr>
</tbody>
</table>
### To Navigate Spin Boxes

A spin box is a control that allows you to type a numeric value or select a value from a list of all possible values.

#### Figure 3.5. Sample Spin Box

![Sample Spin Box](image)
The keyboard shortcuts that you use to navigate the text box area of a spin box are listed in the section called “To Navigate Text Boxes”. The following table lists the keyboard shortcuts that you can use to navigate the up and down arrows in the spin box.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>up arrow or down arrow</td>
<td>Increase or decrease the value of the spin box by a small amount.</td>
</tr>
<tr>
<td>Page Up or Page Down</td>
<td>Increase or decrease the value of the spin box by a large amount.</td>
</tr>
</tbody>
</table>

### To Navigate Drop-Down Lists

A drop-down list is a control that you use to select one of several available items. The drop-down list contains a button that you use to display the available items.

#### Figure 3.6. Sample Drop-Down List

![Sample Drop-Down List](image)

The following table lists the keyboard shortcuts that you can use to navigate a drop-down list.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>spacebar</td>
<td>This key performs one of the following functions:</td>
</tr>
<tr>
<td></td>
<td>• If the drop-down list is not open, this key opens the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• If the drop-down list is open, this key accepts the current selection and closes the list.</td>
</tr>
<tr>
<td>up arrow</td>
<td>Select the previous list item.</td>
</tr>
<tr>
<td>down arrow</td>
<td>Select the next list item.</td>
</tr>
<tr>
<td>Esc</td>
<td>Close the list without changing the selection.</td>
</tr>
</tbody>
</table>

### To Navigate Drop-Down Combination Boxes

A drop-down combination box is a text box with a drop-down list attached.

#### Figure 3.7. Sample Drop-Down Combination Box

![Sample Drop-Down Combination Box](image)
When the text box has focus, use the keyboard shortcuts that are listed in the section called “To Navigate Text Boxes” to navigate the text box area. When the text box has focus, you can also use the keyboard shortcuts in the following table to navigate the drop-down list area.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>up arrow</td>
<td>Select the previous item from the drop-down list without displaying the list.</td>
</tr>
<tr>
<td>down arrow</td>
<td>Select the next item from the drop-down list without displaying the list.</td>
</tr>
<tr>
<td>Ctrl-down arrow</td>
<td>(Solaris only) Open the drop-down list.</td>
</tr>
</tbody>
</table>

When the drop-down list has focus, you can use the keyboard shortcuts that are listed in the following table to navigate the drop-down list.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>up arrow</td>
<td>Select the previous list item.</td>
</tr>
<tr>
<td>down arrow</td>
<td>Select the next list item.</td>
</tr>
<tr>
<td>Home</td>
<td>Select the first item on the list.</td>
</tr>
<tr>
<td>End</td>
<td>Select the last item on the list.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Select the item at the top of the current list view.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Select the item at the bottom of the current list view.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Accept the current selection and close the drop-down list.</td>
</tr>
<tr>
<td>Ctrl-Page Up</td>
<td>Scroll to the left of the list, if required.</td>
</tr>
<tr>
<td>Ctrl-Page Down</td>
<td>Scroll to the right of the list, if required.</td>
</tr>
</tbody>
</table>

**To Navigate Sliders**

A slider is a control that you use to set a value in a continuous range of values.

**Figure 3.8. Sample Slider**

![Sample Slider](image)

The following table describes the keyboard shortcuts that you can use to navigate a slider.
<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>left arrow or up arrow</td>
<td>Move the slider left or up by a small amount.</td>
</tr>
<tr>
<td>right arrow or down arrow</td>
<td>Move the slider right or down by a small amount.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Move the slider left or up a large amount.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Move the slider right or down a small amount.</td>
</tr>
<tr>
<td>Home</td>
<td>Move the slider to the maximum value.</td>
</tr>
<tr>
<td>End</td>
<td>Move the slider to the minimum value.</td>
</tr>
</tbody>
</table>

To Navigate Tabbed Sections

Figure 3.9. Sample Dialog with Tabbed Sections
Windows and dialogs are sometimes divided into logical sections that are displayed one section at a time on the window or dialog. The divisions are called tabbed sections that are identified by a tab with a text label.

The following table lists the keyboard shortcuts that you can use to navigate the tabbed sections of a window or dialog when a tab name has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>left arrow</td>
<td>Give focus to the previous tabbed section.</td>
</tr>
<tr>
<td>right arrow</td>
<td>Give focus to the next tabbed section.</td>
</tr>
<tr>
<td>Tab or Ctrl-down arrow</td>
<td>Give focus to the first control on the active tabbed section.</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts that you can use to navigate the tabbed sections of a window or dialog when a control on a tabbed section has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-Page Up or Ctrl-Alt-Page Up</td>
<td>Give focus to the previous tabbed section.</td>
</tr>
<tr>
<td></td>
<td>This keyboard shortcut does not work if the focused control uses Ctrl-Page Up for another purpose.</td>
</tr>
<tr>
<td>Ctrl-Page Down or Ctrl-Alt-Page Down</td>
<td>Give focus to the next tabbed section.</td>
</tr>
<tr>
<td></td>
<td>This keyboard shortcut does not work if the focused control uses Ctrl-Page Down for another purpose.</td>
</tr>
<tr>
<td>Ctrl-Tab</td>
<td>Give focus to the next control outside the tabbed sections.</td>
</tr>
</tbody>
</table>

**To Navigate Lists**

The following table lists the keyboard shortcuts that you can use to navigate multi-column lists when a column header has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>left arrow or right arrow</td>
<td>Give focus to the previous or next column header.</td>
</tr>
<tr>
<td>spacebar</td>
<td>Activate the header. This action usually sorts the list by the column header.</td>
</tr>
<tr>
<td>Tab</td>
<td>Give focus to the list contents.</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts that you can use to navigate lists when the contents of the list has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keys</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>arrow keys</td>
<td>Select the next or previous row or column.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Select the top row of the list contents that are in view. Press Page Up again to select the top row of the previous view.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Select the bottom row of the list contents that are in view. Press Page Down again to select the bottom row of the next view.</td>
</tr>
<tr>
<td>Home</td>
<td>Select the first row in the list.</td>
</tr>
<tr>
<td>End</td>
<td>Select the last row in the list.</td>
</tr>
<tr>
<td>Shift + arrow keys</td>
<td>For lists that support multi-line selections, add the next or previous row or column to the current selection. For lists that only allow single line selections, select the next or previous row or column.</td>
</tr>
<tr>
<td>Shift-Page Up</td>
<td>Select all the rows between the current selection and the top row of the view.</td>
</tr>
<tr>
<td>Shift-Page Down</td>
<td>Select all the rows between the current selection and the bottom row of the view.</td>
</tr>
<tr>
<td>Shift-Home</td>
<td>Select all the rows between the current selection and the first row in the list.</td>
</tr>
<tr>
<td>Shift-End</td>
<td>Select all the rows between the current selection and the last row in the list.</td>
</tr>
<tr>
<td>Ctrl + arrow keys</td>
<td>Give focus to the next row or column but do not extend the selection. Further items can be selected by pressing the spacebar.</td>
</tr>
<tr>
<td>Ctrl-Page Up</td>
<td>Give focus to the top row in the view but do not extend the selection.</td>
</tr>
<tr>
<td>Ctrl-Page Down</td>
<td>Give focus to the bottom row in the view but do not extend the selection.</td>
</tr>
<tr>
<td>Ctrl-Home</td>
<td>Give focus to the first row in the list but do not extend the selection.</td>
</tr>
<tr>
<td>Ctrl-End</td>
<td>Give focus to the last row in the list but do not extend the selection.</td>
</tr>
<tr>
<td>Return</td>
<td>Activate the item.</td>
</tr>
<tr>
<td>Ctrl-A</td>
<td>For lists that support multiline selections, select all rows in the list.</td>
</tr>
<tr>
<td>Shift-Tab</td>
<td>Give focus to the column header, if applicable.</td>
</tr>
</tbody>
</table>
To Navigate Trees

A tree is a user interface control that contains sections that you can expand and collapse. A tree usually represents a hierarchical structure.

Figure 3.10. Sample Tree Structure

To navigate trees, you can use the same keyboard shortcuts that are listed in the section called “To Navigate Lists”. In addition, the following table lists the keyboard shortcuts you can use for the tree items.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (plus)</td>
<td>Expand the focused item.</td>
</tr>
<tr>
<td>- (minus)</td>
<td>Collapse the focused item.</td>
</tr>
<tr>
<td>Back Space</td>
<td>Select the parent item.</td>
</tr>
<tr>
<td>Ctrl-F</td>
<td>Display a search dialog if the tree supports searching. You can type the name of the tree item that you want to find.</td>
</tr>
</tbody>
</table>

Customizing Your Keyboard Shortcuts

Use the Keyboard Shortcuts preference tool to display the default keyboard shortcuts that you use to navigate the GNOME Desktop. You can customize the default keyboard shortcuts to meet your requirements. You can also create hot keys. Hot keys are keyboard shortcuts that start applications.

To start the Keyboard Shortcuts preference tool, choose Desktop→Preferences→Keyboard Shortcuts. The Desktop shortcuts table lists the keyboard shortcut that is associated with each action.

To Customize Keyboard Shortcuts on Solaris Systems

To customize a keyboard shortcut on a Solaris system, perform the following steps:
1. Click on the action for which you want to customize the keyboard shortcut. The row is highlighted.
2. Click on the keyboard shortcut in the Shortcut column. The text “Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.
3. Press the keys that you want to associate with the action. The new keyboard shortcut is displayed in the Shortcut column.

To disable a keyboard shortcut, perform the following steps:
1. Click on the action for which you want to disable the keyboard shortcut. The row is highlighted.
2. Click on the keyboard shortcut in the Shortcut column. The text “Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.
3. Press Back Space. The keyboard shortcut is disabled.

**To Customize Keyboard Shortcuts on Linux Systems**

To customize a keyboard shortcut on a Linux system, perform the following steps:

1. Click on the action for which you want to customize the keyboard shortcut. The row is highlighted and the text “Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.
2. Press the keys that you want to associate with the action. The new keyboard shortcut is displayed in the Shortcut column.

To disable a keyboard shortcut, perform the following steps:

1. Click on the action for which you want to disable the keyboard shortcut. The row is highlighted and the text “Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.
2. Press Back Space. The keyboard shortcut is disabled.
Chapter 4

Customizing the Appearance of the Desktop
This chapter describes the methods you can use to change the appearance of the GNOME Desktop to enhance the accessibility of the desktop for users with visual impairments.

## Customization Options

There are a number of methods to enable you to customize the appearance of the GNOME Desktop to suit your specific needs, as follows:

### Themes

Themes are the most effective way to change the appearance of the desktop in a consistent manner. See the section called “Using Themes to Customize the Desktop” for more information about themes and how to use themes to achieve the type of desktop environment that you require.

### Desktop and application-specific configuration settings

You can customize different components of the desktop individually to achieve the display settings that you require. You can configure the desktop and applications in addition to using themes or as an alternative to using themes. See the section called “Customizing Specific Components of the Desktop” for more information.

The following table summarizes the changes that you can make to the GNOME Desktop and where you can make the changes. This guide does not provide detailed instructions about how to customize the desktop. For detailed instructions about how to use the customization tools that the desktop provides, refer to the Help for each tool or to the User Guide [ghelp:user-guide?prefs].

### Table 4.1. Quick Reference to Customizing the Appearance of the Desktop

<table>
<thead>
<tr>
<th>To change the...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall appearance of the desktop to use high contrast colors, low contrast colors, or large print.</td>
<td>The Theme preference tool.</td>
</tr>
<tr>
<td>Appearance of the desktop background only.</td>
<td>The Desktop Background preference tool and the file manager Backgrounds and Emblems menu item.</td>
</tr>
<tr>
<td>Font displayed on the desktop background and in all desktop applications.</td>
<td>The Font preference tool.</td>
</tr>
<tr>
<td>Default font settings of the Text Editor, Terminal or Help application.</td>
<td>By default, these applications use the default application font that is specified in the Font preference tool but can be overridden in the Preferences dialog for the application.</td>
</tr>
</tbody>
</table>

## Using Themes to Customize the Desktop

This section describes how to use themes to customize the appearance of the GNOME Desktop.

### Introduction to Themes

A theme is a group of coordinated settings that specifies how a desktop component or a group of desktop compon-
You can use themes to modify and control the appearance of the desktop in a consistent manner. When you apply a theme, the system modifies many desktop components simultaneously to achieve the desired effect. For example, if you apply a theme that increases the font size across the desktop, the theme also modifies the size of panels and icons on the desktop for optimum compatibility with the font size.

A theme contains settings that affect different parts of the desktop as follows:

Controls
The controls setting for a theme determines the visual appearance of all windows, applications, panels, and panel applications. The controls setting also determines the visual appearance of the GNOME-compliant interface items that appear on windows, applications, panels, and panel applications, such as menus, icons, and buttons. Some of the controls options that are available in the desktop are designed for special accessibility needs.

Window border
The window frame setting determines the appearance of the border around windows only.

Icon
The icon setting determines the appearance of icons on panels and on the desktop background.

To Choose a Theme

To choose a theme, perform the following steps:

1. Choose Desktop→Preferences→Theme. The themes are listed on the left side of the Theme Preferences dialog.
2. Click on a theme in the list box to choose a new theme. The system automatically applies the theme to the desktop.

There are several themes available that suit different accessibility needs, as described in the following table:

<table>
<thead>
<tr>
<th>Theme Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Contrast</td>
<td>Provides dark text on a light background using high contrast colors.</td>
</tr>
<tr>
<td>High Contrast Inverse</td>
<td>Provides light text on a dark background using high contrast colors.</td>
</tr>
<tr>
<td>Large Print</td>
<td>This theme suggests an increased font size of 18pt. The background and foreground colors are the same as those specified by the Default desktop theme. To apply the suggested font, click on the Apply Font button.</td>
</tr>
<tr>
<td>High Contrast Large Print</td>
<td>This theme suggests an increased font size of 18pt using dark text on a light background. To apply the suggested font, click on the Apply Font button.</td>
</tr>
<tr>
<td>High Contrast Large Print Inverse</td>
<td>This theme suggests an increased font size of 18pt using light text on a dark background. To apply the suggested font, click on the Apply Font button.</td>
</tr>
</tbody>
</table>

To view the controls, window frame, and icon settings that are associated with a theme, select a theme in the Theme Preferences dialog, then click on the Theme Details button. The Theme Details dialog contains a tabbed section for each setting category. Each tabbed section lists the options that are available and the current setting for the theme is
To Modify the Controls Setting for a Theme

To modify the controls setting that is associated with a theme, perform the following steps:

1. In the Theme Preferences dialog, select the theme that you want to modify.
2. Click on the Theme Details button. The Theme Details dialog is displayed.
3. Click on the Controls tab to display the controls options that are available.
4. Select the controls option that you want to associate with the current theme from the list box, then click Close.

The following table lists the controls options that are suitable for accessibility needs.

Table 4.3. Controls Options Designed for Accessibility Requirements

<table>
<thead>
<tr>
<th>Control Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HighContrast</td>
<td>Provides dark text on a light background using high contrast colors.</td>
</tr>
<tr>
<td>HighContrastInverse</td>
<td>Provides light text on a dark background using high contrast colors.</td>
</tr>
<tr>
<td>LowContrast</td>
<td>Uses low contrast colors for the background and foreground text.</td>
</tr>
<tr>
<td>LargePrint</td>
<td>Increases the size of controls to accommodate larger fonts. To increase the font size, you must use the Font preference tool. The background and foreground colors are the same as those specified by the Default desktop theme.</td>
</tr>
<tr>
<td>HighContrastLargePrint</td>
<td>Provides dark text on a light background using high contrast colors. Increases the size of controls to accommodate larger fonts. To increase the font size, you must use the Font preference tool.</td>
</tr>
<tr>
<td>HighContrastLargePrintInverse</td>
<td>Provides light text on a dark background using high contrast colors. Increases the size of controls to accommodate larger fonts. To increase the font size, you must use the Font preference tool.</td>
</tr>
<tr>
<td>LowContrastLargePrint</td>
<td>Uses low contrast colors for the background and foreground text. Increases the size of controls to accommodate larger fonts. To increase the font size, you must use the Font preference tool.</td>
</tr>
</tbody>
</table>

To Modify the Window Border Setting for a Theme

To modify the window border setting that is associated with a theme, perform the following steps:

1. In the Theme Preferences dialog, select the theme that you want to modify.
2. Click on the Theme Details button. The Theme Details dialog is displayed.
3. Click on the Window Border tab to display the window frame options that are available.
4. Select the window frame option that you want to associate with the current theme from the list box, then click Close. The Atlanta option is an accessible option.

**To Modify the Icon Setting for a Theme**

To modify the icon setting that is associated with a theme, perform the following steps:

1. In the Theme Preferences dialog, select the theme that you want to modify.
2. Click on the Theme Details button. The Theme Details dialog is displayed.
3. Click on the Icons tab to display the icon options that are available.
4. Select the icon option that you want to associate with the theme from the list box, then click Close. The following table lists the icon options that are suitable for accessibility needs.

<table>
<thead>
<tr>
<th>Icon Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HighContrast</td>
<td>Provides dark on light icons using high contrast colors.</td>
</tr>
<tr>
<td>HighContrastInverse</td>
<td>Provides light on dark icons using high contrast colors.</td>
</tr>
<tr>
<td>LowContrast</td>
<td>Uses low contrast colors for the background and foreground text.</td>
</tr>
</tbody>
</table>

**To Create Your Own Themes**

For information about how to create your own themes, see the System Administration Guide [ghelp:system-admin-guide?themes-0].

**Customizing Specific Components of the Desktop**

This section describes how to customize specific components of the desktop individually.

**To Customize the Desktop Background**

The themes do not affect the desktop background. Therefore to modify the desktop background to complement your desktop, you must customize the desktop background separately using the Desktop Background preference tool. To start the Desktop Background preference tool, choose Desktop→Preferences→Desktop Background.

**To Customize Desktop Background Objects**

The size of the icons that are displayed on the desktop background is controlled by the File Management preference tool. To change the size of the icons, perform the following steps:

1. From the File Manager window, choose the Edit→Preferences menu item.
2. Select the Views tabbed section.

3. In the Icon View Defaults group, select the zoom level that you require in the Default zoom level drop-down list.

**To Customize Fonts**

This section describes how to customize the font settings for the desktop and frequently-used applications.

If you have difficulty with the default font type and font size that is used on the desktop and desktop background, you can customize the font settings to suit your needs.

You can specify individual font settings for the following desktop components and applications:

- Entire desktop excluding the desktop background
- Desktop background only
- Terminal
- Text editor
- Help
- Web Browser

**To Customize the Desktop Fonts**

The Font preference tool allows you to specify the default fonts for the desktop.

To start the Font preference tool, choose Desktop→Preferences→Font. The Font Preferences dialog contains the following options:

**Application font**

Click on this button to select a default font to use for the text that is displayed on the desktop, including the text displayed on the windows and dialogs associated with GNOME-compliant applications and panel applications.

If you use the Theme preference tool to select a theme and you click on the Apply Font button, the font that is associated with the theme overrides the font that you select using the Font preference tool.

**Document font**

Click on this button to select a font to use for displaying documents.

**Desktop font**

Click on this button to select a font to use for the text that is displayed on the desktop background only.

**Window title font**

Click on this button to select a font to use for the text that is displayed in titlebars of your windows.

**Fixed width font**

Click on this button to select a font to use for editing documents.

**Font rendering**

To specify how to render fonts on the desktop, select one of the following options:

- Monochrome
- Best shapes
- Best contrast
- Subpixel smoothing
If you use large fonts, you may need to change the size of panes in applications that use panes such as, the file manager and the Help browser.

For more information about the Font preference tool, see the User Guide [ghelp:user-guide?prefs-font].

To Customize Application Fonts

By default, GNOME applications use the default font specified in the Font preference tool. Some applications allow this default font to be customized. These applications are:

• Help Browser [ghelp:user-guide#yelp]
• Text Editor [ghelp:gedit?gedit-prefs-fontsandcolors]
• Terminal [ghelp:gnome-terminal#gnome-terminal-prefs-general]
• Web Browser [ghelp:epiphany#ephy-customize]

Meeting Specific Accessibility Needs

The following sections summarize the steps you need to take to improve the accessibility of the desktop in a particular area.

To Achieve a High or Low Contrast Desktop

To achieve a high or low contrast desktop, perform the following steps:

1. Use the Theme preference tool to select the high contrast or low contrast desktop theme that you require.
2. Use the Desktop Background preference tool to customize your desktop background as follows:
   - Set the Desktop Wallpaper to No Wallpaper.
   - Set the Desktop Colors to Solid Color.
   - Select a background color that suits your needs.
3. In the Terminal application, ensure that the Use colors from system theme option is selected in the Colors tabbed section of the Editing Profile dialog.
4. In the gedit application, ensure that the Use default theme colors option is selected in the Fonts & Colors tabbed section of the Preferences dialog.

To Achieve a Large Print Desktop

To achieve a large print desktop, perform the following steps:

1. Use the Theme preference tool to select the Large Print theme.
2. Click on the Apply Font button to increase the size of the font that is used on the desktop and on window frames.
3. Use the Desktop font option in the Font preference tool to increase the font that is displayed on desktop background objects.
4. Increase the font size that is used to display the contents of the Terminal application window.
5. If the Use default theme font option is selected in the gedit Preferences dialog, gedit uses the font size that is specified in the large print theme that you selected. However, if the Use default theme font option is not selected, increase the font size that is used to display the contents of the gedit text editor window. See the gedit

6. If you use applications that use panes, such as the file manager and the Help browser, you may need to change the size of panes to accommodate the large print. See the online help for the appropriate application for more information.
Chapter 5

Using the Assistive Technologies
The GNOME Desktop contains the following applications to enable users with a physical disability to use the desktop:

- On-Screen Keyboard
- Screen Reader and Magnifier

Before you can use the On-Screen Keyboard and Screen Reader and Magnifier on Solaris systems, you must follow the steps outlined in the section called “Enabling XKB on Solaris Systems” of this guide.

**On-Screen Keyboard**

The On-Screen Keyboard application displays virtual keyboards on your desktop. You can use the standard mouse pointer or alternative pointing device to operate the virtual keyboards. On-Screen Keyboard displays the following types of keyboards:

- Compose keyboards that enable you to compose text. To type alphanumeric characters, you select the characters on the compose keyboard.
- Dynamic keyboards that On-Screen Keyboard generates to reflect the applications that are currently running on the desktop. For example, On-Screen Keyboard generates keyboards that contain keys to represent the applications that are running on your desktop or the menus that are contained in an application.

To start On-Screen Keyboard, choose Applications→Accessibility→On-Screen Keyboard. For more information about the On-Screen Keyboard application, see the Help for On-Screen Keyboard [ghelp:gok].

**Maximizing Application Windows for On-Screen Keyboard Users**

If you are an On-Screen Keyboard user, you cannot use any application in Full Screen mode because the application window obscures the On-Screen Keyboard display.

To resize the window for use with the On-Screen Keyboard application, perform the following steps:

1. Do not enable the Full Screen mode in the application.
2. Give focus to the application window.
3. Press **F10** to maximize the application.

**Screen Reader and Magnifier**

The Screen Reader and Magnifier application enables users with limited vision, or no vision, to use the GNOME Desktop and associated applications. Screen Reader and Magnifier provides the following functionality:

- Screen reader
  
The screen reader enables non-visual access to standard applications in the GNOME Desktop, using speech and Braille output.
- Magnifier
  
The magnifier provides automated focus tracking and fullscreen magnification to aid low-vision users.
To start Screen Reader and Magnifier, choose Applications→Accessibility→Screen Reader and Magnifier. For more information about the application, see the online Help for Screen Reader and Magnifier [ghelp:gnopernicus].

**Disabling the Screensaver**

Before you use On-Screen Keyboard or Screen Reader and Magnifier, you must disable the screensaver. To disable the screensaver, perform the following steps:

1. Choose Desktop→Preferences→Screensaver.
2. Deselect the Activate screensaver when session is idle checkbox.
Appendix A. System Administration

This appendix describes some tasks that a system administrator needs to perform to enable accessible login and to facilitate the use of the assistive technologies that are available in the GNOME Desktop.

Configuring the Desktop for Accessible Login

The GNOME Desktop includes an Accessible Login feature. The Accessible Login feature enables users to:

- Log in to the desktop even if the user cannot easily use the screen, mouse, or keyboard in the usual way.
- Launch assistive technologies at login time by associating a user action with an assistive technology application. The user can perform the user action from the standard keyboard, or from a keyboard, pointing device, or switch device that is attached to the USB or PS/2 mouse port. These user actions are called gestures.
- Change the visual appearance of the login dialog before the user logs in, for example, to use a high contrast theme for better visibility.

To Enable Accessible Login

To enable the Accessible Login feature for the GNOME Desktop, you must configure the desktop to use the GNOME Display Manager (GDM) as the login manager. GDM is the default login manager on Linux systems but not on Solaris systems, therefore the instructions to enable Accessible Login differ depending on the platform you are using.

To Enable and Configure GDM on Solaris Systems

To enable and configure GDM as the login manager on Solaris systems, perform the following steps:

1. Log in as the root user.
2. Open the file /etc/X11/gdm/gdm.conf.
3. Search the file for the following line:
   
   #AddGtkModules=false
   
   and replace the line with the following:
   
   AddGtkModules=true
   
   This step enables the GtkModules.
4. Search the file for the following line:
   
   #GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener
   
   and delete the # from the start of the line so that the line reads:
   
   GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener
   
   The above lines must be displayed as single lines in the gdm.conf file without line breaks. The formatting of this guide may display the lines over two lines.
   
   This step loads all of the GtkModules to enable assistive technologies such as On-Screen Keyboard and Screen Reader and Magnifier. You can edit the line above further to load only the GtkModules that you require to sup-
port the user base. For example:

• If you need to use the Screen Reader and Magnifier, include gail and atk-bridge.
• If you need to use a pointing device without buttons or switches, include gail, atk-bridge, and dwellmouselistener.
• If you use pointing devices with switches, alternative physical keyboards, or switch and button devices, include keymouselistener.
• On-Screen Keyboard can operate without gail and atk-bridge but with a reduced feature set.

For optimum accessibility, include gail and atk-bridge.

5. Save the /etc/X11/gdm/gdm.conf file.
6. Enter the following command to stop the dtlogin manager:

/usr/dt/bin/dtconfig -d

7. Enter the following commands to configure GDM as the login manager:

svccfg import /var/svc/manifest/application/gdm2-login.xml
svcadm enable application/gdm2-login

If you make any changes to the /etc/X11/gdm/gdm.conf file after you enable GDM, you can execute the following command to restart GDM and activate the changes:

gdm-restart

8. Edit the file /etc/passwd to append the following to the end of the gdm line:

:/:etc/X11/gdm/home

9. Create the /etc/X11/gdm/home directory and assign ownership of the directory to the gdm user.
10. Restart your system.

To Configure GDM on Linux Systems

To configure GDM on Linux systems, perform the following steps:

1. Log in as the root user.
2. Open the file /etc/X11/gdm/gdm.conf.
3. Search the file for the following line:

   #AddGtkModules=false

and replace the line with the following:

   AddGtkModules=true

This step enables the GtkModules.

4. Search the file for the following line:

   #GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener

and delete the # from the start of the line so that the line reads:
GtkModulesList=gail:atk-bridge:dwellmouselistener:keymouselistener

The above lines must be displayed as single lines in the gdm.conf file without line breaks. The formatting of this guide may display the lines over two lines.

This step loads all of the GtkModules to enable assistive technologies such as On-Screen Keyboard and Screen Reader and Magnifier. You can edit the line above further to load only the GtkModules that you require to support the user base. For example:

- If you need to use the Screen Reader and Magnifier, include gail and atk-bridge.
- If you need to use a pointing device without buttons or switches, include gail, atk-bridge, and dwellmouselistener.
- If you use pointing devices with switches, alternative physical keyboards, or switch and button devices, include keymouselistener.
- On-Screen Keyboard can operate without gail and atk-bridge but with a reduced feature set.

For optimum accessibility, include gail and atk-bridge.

5. Save the /etc/X11/gdm/gdm.conf file.

If you make any changes to the /etc/X11/gdm/gdm.conf file after you enable GDM, you can execute the following command to restart GDM and activate the changes:

gdm-restart

6. Edit the file /etc/group and append the following to the audio line:

   ,gdm

This step ensures that speech works with GDM.

7. Restart your system.

To Start Assistive Technologies at Login

If you load the keymouselistener and dwellmouselistener GtkModules in the GDM configuration file, you can assign user actions to launch specific assistive technologies at login time. These user actions are called gestures. The gesture associations are contained in the following GDM configuration files:

- /etc/X11/gdm/modules/AccessKeyMouseEvents
- /etc/X11/gdm/modules/AccessDwellMouseEvents

If you modify these files, you must restart your system before the changes take effect.

The following sections contain examples of the gestures that you can add to the GDM configuration files.

The gestures must be contained in a single line in the AccessKeyMouseEvents file without line breaks. The formatting of this guide might display the examples in the following sections over two lines.
To Start Screen Reader Using a Keyboard Shortcut

Edit the AccessKeyMouseEvents file to associate keyboard shortcuts with assistive technologies. For example, the following line enables you to press-and-hold Ctrl-S for one second to start Screen Reader and Magnifier in speech and Braille mode:

**Solaris:**

<Control>s 1 1000 10000 /usr/sfw/bin/srcore --login --disable-magnifier --enable-speech --enable-braille

**Linux:**

<Control>s 1 1000 10000 srcore --login --disable-magnifier --enable-speech --enable-braille

To Start Magnifier Using a Keyboard Shortcut

Edit the AccessKeyMouseEvents file to associate keyboard shortcuts with assistive technologies. For example, the following line enables you to press-and-hold Ctrl-M for one second to start Screen Reader and Magnifier in magnifier mode:

**Solaris:**

<Control>m 1 1000 10000 /usr/sfw/bin/srcore --login --disable-magnifier --enable-speech

**Linux:**

<Control>m 1 1000 10000 srcore --login --enable-magnifier --disable-speech

To Start On-Screen Keyboard Using a Switch or Button Gesture

Edit the AccessKeyMouseEvents file to associate switch, key, or button gestures with assistive technologies. Since the primary input device for many On-Screen Keyboard users is a switch or button, this is a good way to enable users to start On-Screen Keyboard at login time.

If there is a tendency for a user to start an application unintentionally, you can associate the gestures with multiple switch presses or minimum durations. For example, the following line starts On-Screen Keyboard in inverse scanning mode when the user presses the switch that is defined as Switch 2 three times within two seconds, for a minimum of 100 milliseconds for each press:

**Solaris:**

<Switch2>3 100 2000 /usr/sfw/bin/gok --login --accessmethod=inversescanning --scan-action=switch1 --select-action=switch2

**Linux:**

<Switch2>3 100 2000 gok --login --accessmethod=inversescanning --scan-action=switch1 --select-action=switch2

Users who use single switches may prefer to start On-Screen Keyboard in automatic scanning mode. The following line starts On-Screen Keyboard in automatic scanning mode when the user presses the switch on an alternative access device for more than four seconds:

**Solaris:**

<Switch>1 4000 5000 /usr/sfw/bin/gok --login --accessmethod=automaticscanning
To Start On-Screen Keyboard Using a Motion-only Gesture

You can define gestures that involve only the motion of a pointing device such as a mouse, or an alternative pointing device, such as a head pointer or trackball. The syntax of the gesture does not change depending on whether you are using a mouse or an alternative pointing device. Edit the `AccessKeyMouseEvents` file to associate motion gestures with assistive technologies.

If the `dwellmouselistener` GtkModule is loaded, alternative pointing devices are temporarily latched to the core pointer. This means that if the user moves the alternative pointing device, the onscreen pointer moves.

For example, the following line starts On-Screen Keyboard in dwell mode when the user moves the onscreen pointer from inside the login dialog through the top edge, back into the dialog through the top edge, out of the dialog through the left edge, back into the dialog through the left edge, and similarly through the bottom and right edges of the dialog in a cross pattern:

Solaris:

```
TTLLBBRR O 10000 /usr/sfw/bin/gok --login --access-method=dwellselection -
```

Linux:

```
TTLLBBRR O 10000 gok --login --access-method=dwellselection -
```

Note that the `--input-device` parameter specified in the gesture must match the name of the extended user input device, such as a head pointer or trackball, as specified in `/etc/X11/XF86Config`.

Additional Requirements for Accessible Login

To enable the Accessible Login feature to use alternative pointing devices and switch devices such as sip-and-puff switches, wheelchair-mounted switches, or trackballs, you might need to modify your X server system configuration to recognize these devices. You can use most devices that emulate mouse buttons with the Accessible Login feature and On-Screen Keyboard, including USB single switches and mouse-like pointing devices.

You should not configure an alternative input device to control the primary onscreen pointer. This might result in undesirable behavior or cause situations from which the user of the alternate input device cannot recover without using the primary keyboard or mouse. To prevent this problem, please remove any occurrences of the attributes `SendCore` or `AlwaysCore` from any of `InputDevice` lines in the X Server configuration file.

Configuring the Java Environment for Accessibility on Solaris Systems

To configure the Java environment on Solaris systems for accessibility, perform the following steps:
1. Log in as the root user to the base directory of the Java SDK installation.
2. Enter the following command:
   ```
   cd jre/lib
   ```
3. Enter the following command:
   ```
   ln -s /usr/share/jar/accessibility.properties
   ```
4. Enter the following command:
   ```
   cd ext
   ```
5. Enter the following command:
   ```
   ln -s /usr/share/jar/gnome-java-bridge.jar
   ```

### Enabling XKB on Solaris Systems

If you are using the desktop for the Solaris operating system on a SPARC platform, you must enable XKB on your system before you can use the AccessX preference tool, Screen Reader and Magnifier, or On-Screen Keyboard.

**XKB is not currently supported on Sun Ray systems.**

To enable XKB on a non-Sun Ray Solaris system, perform the following steps:

1. Log in as the root user.
2. Check if the path and file `/etc/dt/config/Xservers` exists on your system.
3. If the `/etc/dt/config` directory does not exist, enter the following command:
   ```
   mkdir -p /etc/dt/config
   ```
4. If the `Xservers` file is not present, enter the following command:
   ```
   cp /usr/dt/config/Xservers /etc/dt/config/Xservers
   ```
5. Open the `Xservers` file in a text editor and scroll to the end of the file.
6. Append the following to the command line at the end of the file:
   ```
   +kb
   ```
7. Save and close the `Xservers` file.
8. Enter the following command at a command line:
   ```
   pkill -HUP dtlogin
   ```
9. Open the `/etc/X11/gdm/gdm.conf` file in a text editor.
10. Scroll towards the end of the file until you see the line `[server - standard]`.
11. Edit the command line in this section to append the following to the end of the line:
    ```
    +accessx +kb
    ```
12. Save and close the `gdm.conf` file.
13. Log out of your session and log in again.
14. To verify if XKB is running, execute the following command:

   `xdpyinfo`  

   then search for XKEYBOARD in the extensions list.

## Enabling Full Screen Magnification

The following sections describe the methods to enable full screen magnification.

### To Enable Full Screen Magnification Using Two Video Cards

To enable full screen magnification in Screen Reader and Magnifier using two physical video cards, perform the following steps:

1. Configure two video cards as :0.0 and :0.1.
2. Choose Applications → Accessibility → Screen Reader and Magnifier.
3. Click on Preferences in the Gnopernicus menu window.
4. Click on Magnifier to open the Magnifier Preferences dialog.
5. Click on the Add/Modify button to display the Zoomer Options dialog.
6. In the Display Screen section, type :0.0 in the Source text box.
7. In the Display Screen section, type :0.1 in the Target text box.
8. Set the Zoomer Placement values to be [0, 0, 1023, 767].

   ![Light bulb icon]  

   It is not essential that both video cards have the same resolution and bit depth. However, if the resolutions and bit depths of both cards differ greatly, the apparent magnification factor may differ slightly from the nominal magnification factor.

9. Click Apply and Close to close the Zoomer Options dialog.

   The magnified view is displayed on the second display 0.1.

### To Enable Full Screen Magnification Using One Video Card on Linux Systems

To enable full screen magnification on Linux systems using one physical video card and one virtual video card, perform the following steps:

1. Open the file `/etc/X11/XF86Config`.
2. Create a new section at the end of the file as follows:

   ```
   Section "Device"
   Boardname "dummy"
   Driver "dummy"
   Identifier "dummy"
   VendorName "dummy"
   EndSection
   ```
3. Copy the Monitor section and paste it at the end of the file.
4. In the new Monitor section, edit the Identifier line as follows:

   Identifier "MonitorD"

5. Copy the Screen section and paste it at the end of the file.
6. In the new Screen section, edit the Device, Identifier, and Monitor lines as follows:

   Device "dummy"
   Identifier "ScreenD"
   Monitor "MonitorD"

7. Edit the ServerLayout section to change the Screen line as follows:

   Screen "Screen[0]" 0 0

8. Insert the following line in the ServerLayout section:

   Screen "Screen[D]" RightOf "Screen[0]"

9. Save the /etc/X11/XF86Config file.
10. Restart the X Server.
11. Start the Screen Reader and Magnifier application.
12. Click on Startup Mode in the Gnopernicus menu window.
13. Select the Magnifier option in the Startup Mode dialog.
14. Click on Preferences in the Gnopernicus menu window.
15. Click on Magnifier to open the Magnifier Preferences dialog.
16. Click on the Add/Modify button to display the Zoomer Options dialog.
17. In the Display Screen section, type :0.1 in the Source text box.
18. In the Zoomer Placement section, set the value of the Left spin box to 0.
19. Click Apply.

   The Screen Reader and Magnifier user interface is no longer visible.
20. Log out of your session.
21. Log in to a new session.
22. Enter the following command to start Screen Reader and Magnifier in full screen magnification mode:

   gnopernicus -display :0.1

23. When you log out of your session, select the Save current setup option.

Enabling Braille

To enable your system to support Braille output, you must configure the access rights to the serial port to which the Braille device is connected. The following sections describe the steps that you need to perform depending on your operating system.

To Enable Braille on Solaris Systems

To configure the serial port to which the Braille device is connected on Solaris systems, perform the following steps:
1. Log in as the root user.
2. Enter the following command:

   chmod 777 /dev/cua/a

3. Enter the following command:

   chmod 777 /dev/cua/b

4. Change the permissions to 777 on the devices to which the symbolic links /dev/cua/a and /dev/cua/b point.

   If your system uses /dev/cua/a for system log messages, Braille will not work on that serial port. Use /dev/cua/b instead.

To Enable Braille on Linux Systems

To configure the serial port to which the Braille device is connected on Linux systems, perform the following steps:

1. Log in as the root user.
2. Enter the following command:

   chmod 777 /dev/ttyS0

3. Enter the following command:

   chmod 777 /dev/ttyS1

Configuring Alternative Pointer Devices

The following sections describe how to configure your system to use a standard physical mouse and another pointer device such as a single switch device or head tracker device, and how to configure On-Screen Keyboard to use the second pointer device.

To Configure Alternative Pointer Devices on Solaris Systems

To configure an alternative pointer device on a Solaris system, perform the following steps:

   This procedure does not work on all Solaris platforms.

1. Before you connect the alternative pointer device to your system, enter the following command to list the existing devices:

   ls -l /dev/usb/hid*

2. Connect the alternative pointer device to your system.
3. Enter the following command again to list the new device:

   ls -l /dev/usb/hid*

4. Open the file /usr/openwin/server/etc/OWconfig.
5. Add the following lines to the OWconfig file:
To Configure Alternative Pointer Devices on Linux Systems

To configure an alternative pointer device on a Linux system, perform the following steps:

1. Before you connect the alternative pointer device to your system, enter the following command to list the existing devices:

   ```bash
   ls -l /dev/usb/hid*
   ```

2. Connect the alternative pointer device to your system.

3. Enter the following command again to list the new device:

   ```bash
   ls -l /dev/usb/hid*
   ```

4. Open the file /etc/X11/XF86Config.

5. Edit the InputDevice section where the Driver value is set to mouse as follows:

   - Change the Option Device line to the following:
     ```
     Option "Device" "/dev/input/mouse0"
     ```
   - Comment out the Option Protocol line as follows:
     ```
     #Option "Protocol" "explorerps/2"
     ```

     If you are not using USB connections for your primary mouse device and other pointer device, you do not need to carry out this step.

6. Create a new InputDevice section as follows:

   ```
   Section "InputDevice"
   Driver "mouse"
   Identifier "Mouse[3]"
   Option "Device" "/dev/input/mouse1"
   Option "Name" "Autodetection"
   Option "Vendor" "Sysp"
   ```
If you are not using USB connections for your primary mouse device and other pointer device, you do not need to carry out this step.

7. Edit the `ServerLayout` section as follows:
   - Change the `InputDevice "Mouse[1]"` line to the following:
     ```
     InputDevice "Mouse[1]" "CorePointer"
     ```
   - Create a new `InputDevice` line as follows:
     ```
     InputDevice "Mouse[3]"
     ```
   - Remove any occurrences of the attributes `SendCore` or `AlwaysCore` from any of `InputDevice` lines.

   Ensure that only the device that you are using as the primary mouse device has the "CorePointer" attribute and ensure that the alternate input devices do not have the `SendCore` or `AlwaysCore` attributes.

8. Save the `/etc/X11/XF86Config` file.
9. Restart the X Server.

To Configure On-Screen Keyboard to Use an Alternative Pointer Device

To configure the On-Screen Keyboard application to use an alternative pointer device, perform the following steps.

1. Start the On-Screen Keyboard application.
2. Click on GOK in the GOK - main window.
3. Click on Preferences to open the Preferences dialog.
4. Click on the Actions tab.
5. In the Event Source options, select the Other input device option. On-Screen Reader displays the name of the input device that you configured in the text box next to the Other input device option.
6. Click OK to close the GOK Preferences dialog.
Index

A
accessible login feature, 46

B
bounce keys, 8
Braille, enabling, 53

caret navigation mode, 13, 23
configuring two pointer devices
  on Linux systems, 55
  on Solaris systems, 54
cursor
  stop blinking, 5
customizing the desktop appearance, 36
desktop background, 39
desktop background objects, 39
desktop fonts, 40
  fonts, 40
  individual font, 41

g GDM, 46
gestures, 48
Gnopernicus, 44
GOK, 44

H
high contrast desktop, 41

J
Java environment, configuring, 50

K
keyboard accessibility options, 6
Keyboard Accessibility Status panel application, 10
keyboard shortcuts
  customizing, 33
  essential, 13
  for applications, 20
  for buttons, 24
  for check boxes, 25
  for desktop background, 14
  for dialogs, 21
  for drawers, 16
  for drop-down combination boxes, 28
  for drop-down lists, 28
  for file manager, 22
  for Help content, 23
  for lists, 31

  for menus, 24
  for menus on panels, 17
  for paned windows, 20
  for panel applications, 17
  for panels, 15
  for radio buttons, 25
  for sliders, 29
  for spin boxes, 27
  for tabbed sections, 30
  for text boxes, 26
  for windows, 18
  for workspaces, 17
  global, 13
to control a window, 18
to give focus to a window, 18
to move a panel object, 15
to move a window, 19
to resize a window, 19

L
large print desktop, 41
low contrast desktop, 41

M
maximizing Terminal for On-Screen Keyboard users, 44
mouse
  double-click behavior, 4
  left-handed, 4
  locating pointer, 4
  pointer size, 4
  speed and sensitivity, 5
mouse keys, 6

O
On-Screen Keyboard, 44
  configuring for two pointer devices, 56

P
pointer
  size, 4

R
repeat keys, 10

S
Screen Reader and Magnifier, 44
  disabling screensaver, 45
  enabling full screen magnification, 52
Section 508, 2
slow keys, 8
sticky keys, 9

T
themes, 36
  creating your own, 39
Index

desktop, 37
icon, 39
window border, 38
toggle keys
  enabling audio notifications, 10

X
XKB, 51